
Book VIII

Office 2010: 
One Step Beyond



Chapter 1: Customizing 
an Office Program

In This Chapter
✓ Personalizing the Ribbon

✓ Changing around the Quick Access toolbar

✓ Choosing what appears on the status bar

✓ Choosing a new color scheme

✓ Devising keyboard shortcuts in Word

This chapter describes a handful of things you can do to customize Office 
2010 programs. Don’t be afraid to make like a software developer and 

change a program to your liking. Many people are wary of retooling Office 
programs, but you can always reverse the changes you make if you don’t 
like them, as I explain throughout this chapter.

This chapter shows how to put your favorite button commands on the 
Ribbon and Quick Access toolbar. Instead of fishing around for your favorite 
commands, you can assemble them on the Ribbon or Quick Access toolbar 
and locate them right away. You also discover how to change around the 
status bar, dress up an Office program in a new set of clothes, and designate 
your own keyboard shortcuts in Word.

Customizing the Ribbon
As you surely know by now, the Ribbon is the stretch of ground across the 
top of all Office programs. The Ribbon is composed of tabs. On each tab, 
commands are arranged by group. To undertake a task, you visit a tab on 
the Ribbon, find the group with the command you want, and choose the 
command. If you are so inclined, you can customize the Ribbon. You can 
place the tabs and commands you know and love where you want to find 
them on the Ribbon. And you can remove tabs and commands that aren’t 
useful to you.
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Customizing the Quick Access Toolbar
No matter where you go in Office, you see the Quick Access toolbar in the 
upper-left corner of the screen. This toolbar offers the Save, Undo, and 
Repeat buttons. However, which buttons appear on the Quick Access tool-
bar is entirely up to you. You can put your favorite buttons on the toolbar 
to keep them within reach. And if the Quick Access toolbar gets too big, you 
can move it below the Ribbon, as shown in Figure 1-2. Adding buttons to and 
removing buttons from the Quick Access toolbar is, I’m happy to report, a 
piece of cake. And moving the toolbar below the Ribbon is as easy as pie.

 

Figure 1-2: 

Merely 

by right-

clicking, you 

can add a 

button to 

the Quick 

Access 

toolbar.

 

Right-click a button to add it to the toolbar

The Quick Access toolbar below the Ribbon

You can preserve your Ribbon and Quick 
Access toolbar customizations for posterity in 
a special file called an Import Customization 
file; these files have the .exportedUI file 
extension. Keep the file on hand for when you 
need it, or distribute the file to co-workers. For 
that matter, a co-worker who is proud of his or 
her customizations can send them to you in a 
file and you can load the customizations into 
your Office program.

To save your Ribbon and Quick Access toolbar 
customization settings in a file, go to the File 
tab, choose Options, and visit the Customize 

Ribbon or Quick Access Toolbar category 
of the Options dialog box. Then click the 
Import/Export button and choose Export All 
Customizations on the drop-down list. The File 
Save dialog box opens. Give the customizations 
file a name and click the Save button.

To load customizations from a file into your 
Office program, return to the Customize 
Ribbon or Quick Access Toolbar category of 
the Options dialog box, click the Import/Export 
button, and choose Import Customization File. 
You see the File Open dialog box. Select the file 
and click the Open button.

Exporting and importing program customizations
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647Changing the Color Scheme

 ✦ Quick Access toolbar below the Ribbon: Right-click the toolbar, and 
on the shortcut menu, choose Show Quick Access Toolbar Below the 
Ribbon.

 ✦ Quick Access toolbar above the Ribbon: Right-click the toolbar, and 
on the shortcut menu, choose Show Quick Access Toolbar Above the 
Ribbon.

The Options dialog box offers a check box called Show Quick Access 
Toolbar Below the Ribbon (refer to Figure 1-3). You can select this check 
box as well to move the toolbar below the Ribbon.

Customizing the Status Bar
The status bar along the bottom of the window gives you information about 
the file you’re working on. The Word status bar, for example, tells you which 
page you’re on, how many pages are in your document, and several other 
things. In PowerPoint, the status bar tells you which slide you’re looking at 
and the theme you chose for your presentation. The status bar also presents 
the view buttons and Zoom controls.

To choose what appears on the status bar, right-click the status bar. You see 
a drop-down list similar to the one in Figure 1-4. By selecting and deselecting 
items in this list, you can decide what appears on the status bar.

 

Figure 1-4: 

Right-click 

the status 

bar to 

customize it.

 

Changing the Color Scheme
Figure 1-5 shows three color schemes with which you can dress up Excel, 
Outlook, Access, Word, Publisher, and PowerPoint: Blue, Silver, and Black. 
Which do you prefer? Follow these steps to choose a color scheme:
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Figure 1-5: 

Take your 

choice of 

these color 

schemes: 

Blue (top), 

Silver 

(middle), 

or Black 

(bottom).

 

  1. On the File tab, choose Options.

   You see the Options dialog box.

 2. Select the General category.

 3. Open the Color Scheme drop-down list and choose Blue, Silver, 
or Black.

 4. Click OK.

  How do you like your new get-up?

Customizing Keyboard Shortcuts in Word
In Microsoft Word, you can change the keyboard shortcuts. A keyboard short-

cut is a combination of keys that you press to give a command. For example, 
pressing Ctrl+P opens the Print window; pressing Ctrl+S gives the Save com-
mand. If you don’t like a keyboard shortcut in Word, you can change it and 
invent a keyboard shortcut of your own. You can also assign keyboard short-
cuts to symbols, macros, fonts, AutoText entries, and styles.



Chapter 2: Ways of Distributing 
Your Work

In This Chapter
✓ Printing files

✓ Saving files so that others can read them in Adobe Acrobat Reader

✓ Sending a file by e-mail

✓ Saving a file so that it can be viewed in a Web browser

✓ Writing and keeping a blog from inside Word

This chapter explains how to distribute your work to co-workers and 
friends. You’ll be glad to know that people who don’t have Office 2010 

can still read and review an Office 2010 file you created. You can print it for 
them, save it so that it can be read in Adobe Acrobat Reader, or save it as a 
Web page. This chapter explains all that as well as how to send a file right 
away by e-mail and write and post blog entries from inside Word.

By the way, Book IV, Chapter 5 describes other ways to distribute PowerPoint 
presentations. You can provide audience handouts, ship presentations on 
CDs, and save presentations as video files.

Printing — the Old Standby
In spite of predictions to the contrary, the paperless office is still a pipe 
dream. The day when Johnny at his computer is completely digitized and 
communicating with his colleagues without having to print anything on 
paper has yet to materialize. As for Jane, she can hardly go a day without 
printing reports, spreadsheets, and brochures. The office is still awash in 
paper, and all Jane and Johnny can do for consolation is try their best to 
recycle.

  To print a file, preview a file before you print it, and do all else that pertains 
to printing, go to the File tab and choose Print (or press Ctrl+P). You land in 
the Print window, as shown in Figure 2-1. From here, you can choose how 
many copies to print, choose a part of a file to print, and get a look at your 
file before you print it. Notice that the Print window offers buttons for Zoom 
controls and buttons for going from page to page (or slide to slide).
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Figure 2-1: 

Starting in 

the Print 

window, you 

can preview 

and print 

files.

 

Distributing a File in PDF Format
As shown in Figure 2-2, you can save and distribute a file in the PDF 
(Portable Document File) format if the person to whom you want to give 
the file doesn’t have the program with which it was created. For example, 
someone who doesn’t have Excel can still view your Excel file in PDF format. 
Moreover, you can post PDF files on the Internet so that others can view 
them there.

About PDF files
PDF files are designed to be viewed and printed in a program called Adobe 
Reader. This program is very good at acquiring data from other programs 
and presenting it so that it can be read and printed easily. Nearly every 
computer has Adobe Reader. If someone to whom you sent a PDF file doesn’t 
have the program, they can download it for free at this Web page:

http://get.adobe.com/reader/
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Sending Your File in an E-Mail Message
As long as you handle your e-mail with Outlook 2010, you can send the file 
you’re working on to a friend or co-worker without having to open Outlook 
2010. Moreover, you can send a PDF or XPS version of the file. You simply 
choose a command and send the thing over the Internet. Follow these steps 
to send an open file you’re working on to a friend or co-worker:

 

 
1. Go to the File tab and choose Save & Send.

   The Save & Send window opens.

 2. Choose Send Using E-Mail.

 3. Choose a Send Using E-Mail option on the right side of the window.

  How do you want to send your file? Click one of these buttons:

 • Send as Attachment: Send the file as an attachment to an e-mail message.

 • Send a Link: Send an e-mail link with a hyperlink to the file on a 
shared workspace.

 • Send as PDF: Send a PDF version of the file as an attachment to an 
e-mail message.

 • Send as XPS: Send an XPS version of the file as an attachment to an 
e-mail message.

 • Send as Internet Fax: Send the file as an Internet fax (you must have 
signed up with an Internet fax service provider).

  An Outlook 2010 message window appears with the name of your file on 
the subject line and the file itself in the Attach box. Your presentation is 
ready to send along with the e-mail message.

 4. Enter the recipient’s address in the To box and a message in the 
Message box.

  Book III, Chapter 3 explains how to address, compose, and send e-mail 
messages with Outlook.

 5. Click the Send button.

  That was fast! It was faster than opening Outlook and attaching the file 
to the e-mail message on your own.

Saving an Office File as a Web Page
Figure 2-3 shows what a Word document looks like after it is saved as a Web 
page and displayed in a Web browser. Looks like a normal Word document, 
doesn’t it? Anyone with a Web browser can view a Word document or other 
Office file after it’s saved as a Web page. Save an Office file as a Web page 
and post it on the Internet so that people who don’t have Office can view it.
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657Blogging from inside Word

Blogging from inside Word
The word blog is shorthand for Web log. A typical blog is a hodgepodge of 
commentary and links to online news sources and often other blogs where 
topics of concern to the blogger are discussed. Many blogs are online 
diaries. You get a daily picture of what the blogger is interested in — dating, 
technology, politics, and just about anything else under the sun.

To make it easier to keep a blog, Word offers special commands for writing 
blog entries and posting them immediately with a blogging service. Figure 2-4 
shows the blogging feature in action. The title and the blog entry in the 
Word document are transported in toto to the blog without your having to 
enter a password or even visit a blogging service. What’s more, Word offers 
a special Blog Post tab for posting blog entries and managing accounts with 
your blogging service. To take advantage of Word’s blogging feature, you 
must already have an account with a blogging service.

 

Figure 2-4: 

A blog entry 

written 

in Word 

(left) and 

posted to 

a blogging 

service 

(right).

 

Describing a blog account to Word
Word can’t post entries to a blog unless you tell it where the blog is located, 
what your password is, and some other juicy tidbits. As of this writing, Word 
is compatible with these blogging services: Blogger, Community Server, 
Sharepoint Blog, TypePad, and WordPress.



Chapter 3: Handling Graphics

In This Chapter
✓ Understanding the different graphic file formats

✓ Placing a graphic in a Word document, PowerPoint slide, Excel work-
sheet, or Publisher publication

✓ Recoloring, cropping, and otherwise altering a picture

✓ Compressing graphics

✓ Handling graphics with Office Picture Manager

Apicture, so they say, is worth a thousand words. Whether it’s worth 
a thousand words or merely 950 is debatable. What is certain is 

that visuals help people remember things. A carefully chosen image in a 
PowerPoint presentation, Word document, Excel worksheet, or Publisher 
publication helps others understand you better. The image reinforces the 
ideas or information that you’re trying to put across.

This chapter explains how you can make pictures — photographs and 
graphics — part of your Word documents, PowerPoint presentations, Excel 
worksheets, and Publisher publications. It looks into graphic file formats, 
copyrights, and other issues pertaining to graphics as well as how to touch 
up graphics in an Office program and in an auxiliary program called Office 
Picture Manager.

By the way, the next chapter looks at another way to decorate your work 
with images. It looks at using clip art.

All about Picture File Formats
Graphics and photographs come in many different file formats, and as far as 
Office 2010 is concerned, some are better than others. These pages explain 
what you need to know about graphic files to use them wisely in Office files. 
Here, you find out what bitmap and vector graphics are, what resolution 
and color depth are, and how graphic files are compressed.
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 ✦ Lossless compression: To maintain the picture’s integrity, the same 
number of pixels is stored in the compressed file as in the original. 
Because the pixels remain intact, you can change the size of a file that 
has undergone lossless compression without losing picture quality.

 ✦ Lossy compression: Without regard for the picture’s integrity, pixel data 
in the original picture is lost during compression. Therefore, if you try 
to enlarge a picture that has undergone lossy compression, the picture 
loses quality.

Choosing file formats for graphics
 One of the challenges of using graphics and photographs in Office files 

is keeping file sizes to a minimum. A file that is loaded down with many 
photographs can take a long time to load and send over the Internet because 
graphics and photographs make files that much larger. The trick is to find a 
balance between high-quality, high-resolution graphics and the need to keep 
files sizes low. Here are some tips for choosing graphic file formats:

 ✦ Consider sticking with vector graphics if you’re including graphics in 
your file strictly for decoration purposes. As Chapter 4 of this mini-
book explains, Office provides vector clip-art images. These images are 
easy to come by, don’t require very much hard drive space, and can be 
edited inside Word, PowerPoint, Excel, and Publisher.

 ✦ For photographs, make JPEG your first choice for graphics. JPEG images 
have a fairly high resolution. If you intend to post your file on the 
Internet, you can’t go wrong with JPEGs; they are the de facto photograph 
standard on the Internet.

 ✦ If you’re dealing with black-and-white photos or resolution doesn’t 
matter, use GIF files. These files eat up the least amount of hard drive 
space.

The All-Important Copyright Issue
To save any image on the Internet to your computer, all you have to do is 
right-click it and choose Save Picture As. By starting from Google Image 
Search (www.images.google.com), you can scour the Internet for any 
image you need. Never before has it been easier to obtain images for your 
own use.

Still, obtaining images and using them legally are two different matters. 
Would it surprise you to know that the vast majority of graphics can’t be 
used without the owner’s permission? The copyright laws have a “fair use” 
provision for borrowing written words. You can quote others’ words as long 
as you cite the author and work and you don’t quote passages longer than 
250 to a thousand words (the “fair use” provision is vague on this point). 
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665Inserting a Picture in an Office File

The copyright law regarding graphics is quite straightforward. Unless you 
have the owner’s permission, you can’t legally use a graphic.

Sometimes it’s hard to tell who owns a graphic. The artist or photographer 
(or his or her estate) doesn’t necessarily own the copyright because artists 
sometimes relinquish their copyrights when they create works for hire. The 
only way to get permission to use a graphic is to ask. Contact the owner of 
the Web site with the image you want, the publisher if the image is in a book, 
or the museum if the work is owned by a museum. You will be asked to write 
a letter describing precisely how you intend to use the image, reproduce it, 
and distribute it. Your letter should also say how long you intend to use it 
and at what size you intend to reproduce it.

Inserting a Picture in an Office File
After you’ve weighed the merits of different kinds of graphics and decided 
which one is best for you, you can insert it. Inserting a picture is as simple 
as choosing it in the Insert Picture dialog box. Follow these steps to insert 
a picture on a PowerPoint slide, Word document, Excel worksheet, or 
Publisher page:

 1. Go to the Insert tab.

  2. Click the Picture button.

   You see the Insert Picture dialog box, as shown in Figure 3-2. In 
PowerPoint, you can also open this dialog box by clicking the picture 
icon in a content placeholder frame.

 

Figure 3-2: 

You can 

preview a 

picture file 

before you 

insert it.

 

Choose a Views option Select a picture file
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667Touching Up a Picture

Touching Up a Picture
Every picture can be a collaboration. You can do the following to make a 
picture your own as well as the work of the original artist:

 ✦ Softening and sharpening: Mute or polish a picture. See “Softening and 
sharpening pictures,” later in this chapter.

 ✦ Changing the brightness and contrast: Adjust a picture’s tone. See 
“Correcting a picture’s brightness and contrast.”

 ✦ Recoloring: Give your picture a brand-new set of colors or gray shades. 
See “Recoloring a picture.”

 ✦ Choosing an artistic effect: Take your picture for a walk on the wild 
side. See “Choosing an artistic effect.”

 ✦ Choosing a picture style: Present your picture in an oval fame, soft-edged 
frame, or other type of frame. See “Selecting a picture style.”

 ✦ Cropping: Cut out the parts of a picture that you don’t want. See 
“Cropping off part of a picture.”

 ✦ Removing picture areas: Keep the essentials of a picture and remove 
the rest. See “Removing the background.”

To touch up a picture, visit the (Picture Tools) Format tab. As shown in 
Figure 3-3, you can also open the Format Picture dialog box and choose 
settings in these categories: Picture Corrections, Picture Color, Artistic 
Effects, and Crop. To open the Format Picture dialog box, right-click a 
picture and choose Format Picture on the shortcut menu.

 

Figure 3-3: 

Touching up 

a photo in 

the Format 

Picture 

dialog box.
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  Keep your eye on what’s magenta and what’s not as you use these 
techniques, and consider zooming to 200 percent or more so that you 
can get a good look at your picture:

 • Changing the size of the box: Drag the side and corner handles of the 
box to capture what you want to keep or remove.

 • Marking what you want to keep: Click the Mark Areas to Keep button. 
The pointer changes into a pencil. Click your picture to indicate what 
you want to keep. Each time you click, a keep mark (a plus sign icon) 
appears on your picture.

 • Marking what you want to remove: Click the Mark Areas to Remove 
button. The pointer changes to a pencil. Click your picture to indicate 
what you want to remove. When you click, a remove mark (a minus 
sign) appears.

 • Deleting keep and remove marks: Click the Delete Mark button and 
then click a keep or remove mark to remove a mark and change what 
is and isn’t removed from the picture.

  Of course, you can click the Undo button to backtrack as you work. 
If you get thoroughly lost on the Background Removal tab, click the 
Discard All Changes button and start all over.

  3. Click the Keep Changes button when you finish marking what you 
want to keep and remove.

   How do you like your picture now? If it needs more work, click the 
Remove Background button again and diddle some more on the 
Background Removal tab. Click the Discard All Changes button if you 
want your original picture without the background removed.

Compressing Pictures to Save Hard Drive Space
By compressing pictures, you reduce their file size and consequently 
the size of the file you’re working on. Not all pictures can be compressed, 
as “Compression” explains earlier in this chapter, and some types of 
graphics lose their integrity when they’re compressed. You can’t resize 
lossy-compressed graphics without their looking odd.

Compress pictures to make files load faster and make e-mail messages with 
file attachments travel faster over the Internet. Compressing a picture file 
reduces its pixels per inch (ppi) setting. Follow these steps to compress 
pictures:

 1. Optionally, select the picture or pictures you want to compress if you 
want to compress only one or two.
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  The Compress Pictures command compresses all the graphics in a file 
unless you select graphics first.

 2. Go to the (Picture Tools) Format tab.

  3. Click the Compress Pictures button.

   You see the Compress Pictures dialog box.

 4. Select the Apply to Selected Pictures Only check box if you selected 
graphics in Step 1 and you want to compress only a couple of graphics.

 5. Click the Delete Cropped Areas of Pictures check box if you want to 
delete the unused portions of pictures you cropped.

  As “Cropping off part of a picture” explains earlier in this chapter, Office 
crops graphics in name only. It retains the cropped part of the graphic 
in case you want it back, but you can remove the cropped part as well 
by selecting this check box.

 6. Choose a target output for the pictures.

  These options tell Office which pixels per inch (ppi) setting to use when 
compressing graphics. Which setting you choose depends on where 
you intend to show your graphics. Graphics to be shown on a computer 
monitor need be no more than 72 ppi. If you intend to print your graphics, 
choose a setting in the 600–3000 ppi range. To print for an offset 
publication, choose an even higher setting.

 7. Click OK.

Using Microsoft Office Picture Manager
You may not know it, but you installed a program for managing and editing 
pictures when you installed Office. The program is called Microsoft Office 
Picture Manager, and you can use it to organize graphics and touch up 
graphics before inserting them in a PowerPoint, Word, Excel, or Publisher 
file. As shown in Figure 3-11, Picture Manager displays graphics so that you 
can see precisely what your editorial changes do to them. The program 
makes it easy to find and organize graphic files on your computer. It also 
provides tools for editing graphics.

To open Picture Manager, click the Start button and choose All Programs➪

Microsoft Office➪Microsoft Office 2010 Tools➪Microsoft Office Picture 
Manager. You see the window shown in Figure 3-11. Starting there, you can 
display a graphic on your computer and change its appearance in several 
different ways.



Chapter 4: Decorating Files 
with Clip Art

In This Chapter
✓ Understanding what clip art is

✓ Placing a clip-art image on a page, slide, or worksheet

✓ Changing the look of a clip-art image

✓ Using the Clip Organizer to store, organize, and insert clip art

This chapter explains how you can use clip art to decorate Word documents, 
PowerPoint slides, Excel worksheets, and Publisher publications. You 

also find a treatise on how to use the Microsoft Clip Organizer, an auxiliary 
program for storing clip art and other kinds of media files so that you can 
find the files in a hurry. If you often use media files in your work, you owe it 
to yourself to look into the Clip Organizer.

What Is Clip Art?
In the old days, long before the invention of computers, people would buy 
clip-art books. They would literally cut, or clip, images from these books 
and paste them into posters, letters, and advertisements. Today’s clip art 
is the digital equivalent of old-fashioned clip art. You can paste clip art into 
computer programs such as Word, PowerPoint, Excel, and Publisher. You 
can resize clip-art images without the images losing their integrity. The clip 
art that comes with Office 2010 isn’t encumbered by licensing restrictions; 
it’s in the public domain, and you can use it as you please.

Figure 4-1 shows examples of some clip-art images that come with Office. 
Use images like these to decorate your files. Use them to help illustrate an 
idea or simply to add a little liveliness to your work. In my experience, the 
hardest task where clip art is concerned is finding the right image. You can 
choose from so many images that finding the right one is a chore.
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Figure 4-1: 

Examples 

of clip-art 

images.

 

Inserting a Clip-Art Image
To insert a clip-art image, you open the Clip Art task pane, search in the Clip 
Organizer for the image you want, and insert the image. The trick to finding 
the right image is knowing your way around the Clip Organizer. The majority 
of this chapter explains how to organize the art on your computer so that 
you can get it by way of the Clip Organizer. For now, you can follow these 
basic steps to insert a clip-art image in a page, slide, or worksheet:

 1. Go to the Insert tab.

  2. Click the Clip Art button.

   You see the Clip Art task pane, as shown in Figure 4-2. In PowerPoint, 
you can also click the Clip-Art icon to insert a clip-art image in a content 
placeholder frame.

  The Clip Art task pane is actually an entrée into the Clip Organizer, the 
Microsoft program for organizing and quickly inserting clip art. (The 
Clip Organizer is explained in more detail later in “Handling Media Files 
with the Clip Organizer.”)

 3. In the Search For text box, enter a keyword that describes the clip-art 
image you need.

  Later in this chapter, “Searching for a media file in the Search pane” 
explains how keywords work.

 4. Select the Include Office.com content check box (and make sure that 
your computer is connected to the Internet) to search for images 
online as well as on your computer.

 5. In the Results Should Be drop-down list, choose Illustrations, and if 
you want to search for photos as well, choose Photographs (refer to 
Figure 4-2).
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685Tinkering with a Clip-Art Image’s Appearance

 

Figure 4-2: 

Inserting 

a clip-art 

image by 

way of the 

Clip Art task 

pane.

 

Enter a keyword Choose what to search for

 6. Click the Go button.

  The bottom of the task pane shows the clip-art images found in your 
search. You may have to scroll through the task pane to see all the images.

 7.  Double-click an image or open its drop-down list and choose Insert to 
place it in your Word document, PowerPoint slide, Excel worksheet, 
or Publisher publication.

  Your next task is to move the image into position and perhaps change 
its size. Book I, Chapter 8 explains how to manipulate clip-art images 
and other objects.

Tinkering with a Clip-Art Image’s Appearance
Sometimes a clip-art image doesn’t sit well with the rest of the page, slide, 
or worksheet. The image is too bright or too dark. It clashes with the other 
images. When an image clashes, you don’t have to abandon it in favor of 
another image. As Figure 4-3 shows, you can alter a clip-art image’s appearance 
in different ways.
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Select your image, go to the (Picture Tools) Format tab, and change the 
image’s appearance. Chapter 3 of this mini-book describes the different ways 
to touch up a picture or clip-art image.

 

Figure 4-3: 

You can 

change 

the look of 

a clip-art 

image.

 

Handling Media Files with the Clip Organizer
As computers get faster and better, media files — clip art, graphics, video 
clips, and audio files — will play a bigger role in computing. Dropping a 
clip-art image in a Word document or PowerPoint slide won’t be a big deal. 
Playing video clips on PowerPoint slides will be commonplace.

Well aware that the future is closing in on us, Microsoft created the Clip 
Organizer to help you manage the media files on your computer. By using 
the Clip Organizer, you can place graphics, video clips, and audio files 
in Word documents, PowerPoint presentations, Excel worksheets, and 
Publisher publications. More important, the Clip Organizer is the place to 
organize media files in your computer so that you can find them and make 
good use of them. These pages explain how to manage the Clip Organizer.

To open the Clip Organizer, click the Start button and choose All Programs➪

Microsoft Office➪Microsoft Office 2010 Tools➪Microsoft Clip Organizer.

Knowing your way around the Clip Organizer
As shown in Figure 4-4, the Clip Organizer is divided in two parts, with a 
pane on the left and a window for displaying files on the right. The Clip 
Organizer offers two panes: Collection List and Search.

 ✦ Collection List task pane: Use the Collection List task pane to organize 
your media files and to quickly locate and insert a media file. To display 
the Collection List task pane, click the Collection List button or choose 
View➪Collection List.

 ✦ Search task pane: Use the Search task pane to locate a media file on 
your computer. Notice that this task pane is similar to the Clip Art task 
pane in Office programs (refer to Figure 4-2). To display the Search task 
pane, click the Search button or choose View➪Search.



Chapter 5: Note Taking 
with OneNote

In This Chapter
✓ Getting acquainted with OneNote

✓ Creating notebooks, sections, pages, and subpages for storing notes

✓ Writing and drawing notes

✓ Navigating in OneNote

✓ Organizing and finding stray notes

✓ Selecting, moving, and deleting notes, sections, and pages

✓ Using OneNote in conjunction with other Office programs

Microsoft OneNote is designed for taking notes — at meetings, 
at conferences, or when talking on the telephone. Rather than 

scribble notes indiscriminately in a Word document, you can enter them 
in OneNote and be able to retrieve them later. You can use your notes as 
building blocks for reports and white papers. You can copy them to Excel, 
PowerPoint, Word, or another Office 2010 program. OneNote comes with 
all sorts of amenities for finding and filing notes. OneNote can help you 
brainstorm and organize your ideas.

This chapter explains what OneNote is, how you can use it to write notes, 
and how to organize and find notes. Finally, it explains a couple of tricks for 
recycling notes into other Office programs.

Running OneNote
Do one of the following to run OneNote:

 ✦ Click the Start button and choose All Programs➪Microsoft Office➪

Microsoft Office OneNote 2010.

 ✦ Right-click the OneNote icon in the Notification area (it’s located in the 
lower-right corner of the screen next to the clock) and choose Open 
OneNote. If you don’t see the icon in the Notification area and you want 
to see it there, go to the File tab in OneNote, choose Options on the 
drop-down list, visit the Display category in the Options dialog box, and 
select the Place OneNote Icon in the Notification area of the Taskbar 
check box.
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OneNote opens to the notebook, section, and page that was open the last 
time you closed the program.

 OneNote is unusual among Office programs in that it doesn’t have a Save 
button or Save command. Every 30 seconds, OneNote saves all the notes for 
you. You needn’t concern yourself with whether notes are being saved.

Introducing OneNote
Figure 5-1 shows the OneNote screen. The purpose of OneNote is to help 
you enter notes, keep track of notes, find notes when you need them, and 
organize your notes. Read on to discover how to find your way around 
OneNote and how OneNote organizes notes into notebooks, sections, and 
pages.

 

Figure 5-1: 

The 

OneNote 

screen.

 

Navigation bar Page window (with notes) Page paneSection tabs

Note

Finding your way around the OneNote screen
Apart from the Ribbon along the top of the screen, these are the four main 
areas of OneNote (refer to Figure 5-1):
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Creating Storage Units for Notes
Before you write your first note, give a moment’s thought to organizing 
notes in the notebook-section-pages hierarchy. Think of descriptive names 
for your notebook, sections, section groups, and pages. Then get to work 
creating the storage units you need for your notes. These pages explain how 
to do it.

Creating a notebook
OneNote creates a new notebook for you automatically the first time you 
start the program. This notebook is called Personal. Follow these steps to 
create a new notebook:

  1. On to the File tab, choose New.

   The New Notebook window opens. You can also right-click the 
Notebooks pane and choose New Notebook.

 2. Choose Web, Network, or My Computer to tell OneNote where you 
intend to store the notebook you are about to create.

 3. Enter a name for the notebook.

 4. Select the folder in which you will store the notebook.

  To do so, click the Browse button and select a folder in the Select Folder 
dialog box.

 5. Click the Create Notebook button.

  The new notebook opens on-screen. OneNote creates a section (called 
New Section 1) and a page (called Untitled Page) in your notebook.

 6. Change the name of the section and page.

  Follow these instructions to change section and page names:

 • Changing the section name: Right-click the section name, choose 
Rename on the shortcut menu, and enter a descriptive name. You 
can also double-click a name and enter a new one.

 • Changing the page name: Enter a name in the Title text box at the 
top of the page provided for names. After you enter the name, the 
new name appears as well on the Page pane on the right side of 
the screen.

To delete a notebook, close OneNote, open Windows Explorer or Computer, 
go to the folder where the notebook is stored, and delete the folder. To find 
out where notebooks are stored by default on your computer, go to the 
File tab, choose Options, go to the Save & Backup category of the OneNote 
Options dialog box, and look for the Default Notebook Location.
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Writing Notes
Although the program is called OneNote, you can enter three kinds of notes. 
You can enter typed notes, drawings, and screen clippings. Moreover, if 
you’re using a Tablet PC to scribble your notes, OneNote can (at least in 
theory) recognize whether you’re writing by hand or drawing. These pages 
explain how to type notes, draw notes, and take screen captures in notes.

 

Notes appear in what are called containers, as shown in Figure 5-2. Move the 
pointer over the top of a container and you see the four-headed arrow. At 
that point, you can click and drag a note elsewhere. Drag the right side of a 
note container to change its width.

 

Figure 5-2: 

A typed note 

(left) and a 

drawn note 

(right).

 

Typing a note
To type a note, simply click and start typing. Press the Enter key to begin a 
new paragraph in a note. You can draw upon the commands on the Home 
tab — do you recognize them from Microsoft Word? — to format the text or 
change its color.

  To get more room on a page for notes, try collapsing the Navigation bar and 
page tabs. To do so, press F11 or go to the View tab and click the Full Page 
View button.

Drawing with a pen or highlighter
Follow these steps to draw a note with a pen or highlighter:

  1. On the Draw tab, click the Select & Type button.

  2. Open the Pens gallery and choose a pen or highlighter.

 3. Start drawing.

  Click the Eraser button and click a line if you need to erase something 
you wrote or drew. Choose a shape from the Insert Shape gallery if that 
improves your drawing skills.

 4. Press Esc or click the Select & Type button again when you finish 
drawing or highlighting.
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 ✦ Starting in the Notification tray: Right-click the OneNote icon in the 
Notification tray and choose Create Screen Clipping (or press Windows 
key+S). Then drag the pointer on your screen to capture the part of the 
screen you want for the clipping. The Select Location in OneNote dialog 
box appears. Do one of the following:

 • Select a section in the dialog box and click the Send to Selected 
Location button. OneNote creates a new page in the section you 
chose for the clipping and places the clipping on the page.

 • Click the Copy to Clipboard button. Back in OneNote, right-click a 
page and choose Paste to paste the clipping into OneNote.

 

Figure 5-3: 

A screen 

clipping 

taken from a 

Web page.

 

Getting from Place to Place in OneNote
As you fill up a notebook with sections, section groups, pages, subpages, 
and notes, finding the place you need to be to enter or read a note gets more 
difficult. Here are ways to get from section to section or page to page in the 
OneNote window:

 ✦ Going to a different notebook: Click a notebook button on the 
Navigation bar. Use one of these techniques to find out where clicking a 
notebook button takes you:
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 • Move the pointer over a button. You see a notebook’s name and the 
folder where it is stored in a ScreenTip box.

 • If the Navigation bar is collapsed, click the Expand Navigation Bar 
button. Now you can see the names of notebooks as well as the 
names of notebook sections on the Navigation bar. The Expand 
Navigation Bar button is located at the top of the Navigation bar.

 ✦ Going to a different section or section group: Click the name of a 
section or section group in the Navigation bar or along the top of the 
window. Section group names are listed at the bottom of the Navigation 
bar and to the right of section names. You can expand and collapse 
section groups in the Navigation bar by clicking the plus or minus sign 
on a section group symbol.

 ✦ Go to a different page: Click a page or subpage tab on the right side of 
the window. To make more room for page and subpage names, click the 
Expand Page Tabs button. You can find it to the right of the New Page 
button.

Finding and Keeping Track of Notes
If you’re an habitual note taker, you may find yourself drowning in notes. 
You won’t be able to find the note you’re looking for. The great idea you had 
may be lost forever. To keep notes from getting lost, these pages explain 
how to find stray notes and how to organize notes so that they don’t get lost 
in the first place.

Finding a stray note
To find a lost note, you must be able to remember a word or two in the note. 
Follow these steps to chase down a lost note:

 1. Click in the Search box.

  This box is located to the right of the Section tabs, above the Page pane. 
As soon as you click in the Search box, a menu opens for telling OneNote 
where you want to search.

 2. To declare where you want to search for the note, click the Change 
Search Scope button (it’s on the right side of the Search box) and choose 
This Section, This Notebook, or another option on the drop-down list.

  You can also open this drop-down list by clicking the Type to Search In 
hyperlink.

 3. Enter the word or phrase you’re looking for in the Search box.

 4. Click the Find button.

  OneNote lists all notes with the text you entered.

 5. Click a note to go to the page where it is located.
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To remove a tag, open the Tags gallery and choose Remove Tag.

Arranging tagged notes in the task pane
Follow these steps to arrange notes that you tagged in the Tags Summary 
task pane:

  1. On the Home tab, click the Find Tags button.

   You see the Tags Summary task pane (refer to Figure 5-4).

 2. Open the Group Tags By drop-down list and choose an option.

  These options determine the order in which tagged notes appear in the 
task pane. Tag Name, for example, arranges notes according to which 
icon they’re tagged with; Section arranges notes under section names; 
Note Text arranges notes in alphabetical order.

 3. Open the Search drop-down list and choose an option.

  These options determine which notes appear in the task pane. This 
Section, for example, assembles only flagged notes from the section 
that appears on-screen; This Notebook gathers flagged notes from all 
sections in the notebook you’re viewing.

  A list of notes appears in the task pane.

 4. Click the name of a note you want to visit.

  OneNote opens the page with the note whose name you clicked and 
selects the note.

 

To remove tags from notes, select the notes and press Ctrl+0 (zero), or open 
the drop-down list on the Tags gallery and choose Remove Tag.

Some Housekeeping Chores
Unless you play loud soul music while you’re doing it, housekeeping can 
be a tedious and irksome activity. Here are methods for handling a few 
housekeeping chores:

 ✦ Selecting notes: Click the bar along the top of a note to select it. 
Ctrl+click to select several notes.

 ✦ Moving notes to another page: Use the tried-and-true cut-and-paste 
method. Select the note, right-click, choose Cut, right-click the page 
where you want to move the note, and choose Paste.

 ✦ Moving a page to another section: Right-click the page’s tab and choose 
Move or Copy (or press Ctrl+Alt+M). You see the Move or Copy Pages 
dialog box. Select a section name and click the Move or Copy button.
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 ✦ Removing a notebook from the Navigation bar: To remove a note-
book’s name from the Navigation bar and keep the bar from getting 
too crowded, right-click the notebook’s button and choose Close This 
Notebook. To reopen a notebook, go to the File tab, choose Open, click 
the Open Notebook button, and select the notebook’s name in the Open 
Notebook dialog box.

 ✦ Deleting notes: Select the notes you want to delete and press the Delete 
key or right-click and choose Delete.

 ✦ Deleting a section: Right-click the section tab and choose Delete. 
Because each section is actually a file, you can recover a section you 
deleted accidentally by retrieving it from the Recycle Bin.

 ✦ Deleting a page or subpage: Right-click the page tab and choose Delete. 
You can’t recover a page of notes that you delete this way.

  OneNote maintains a Recycle Bin of its own. If you mistakenly delete a 
section or page, you can recover it by going to the Share tab and clicking 
the Notebook Recycle Bin button. Sections and pages you deleted appear 
(deleted pages appear on the Deleted Pages tab). To restore a section or 
page, right-click it, choose Move or Copy, select the section you want to 
restore in the Move or Copy dialog box, and click the Move button.

OneNote and Other Office Programs
OneNote works hand in hand with its brothers and sisters in the Office 
suite. These pages describe how to recycle material from OneNote into 
other Office programs and recycle material from other Office programs into 
OneNote.

Using data from OneNote in other Office programs
To make use of OneNote data in other Office programs, you can copy the 
data, link it to a Word or PowerPoint file, send it by e-mail, or turn it into an 
Outlook task. Better keep reading.

Copying a note into another Office program
To copy a note into another program, use the copy-and-paste command. 
Select the note, right-click, and choose Copy. Then go to the other program, 
right-click, and choose Paste. Typed notes land in the other program in the 
form of text. Drawn notes land as Portable Network Graphics (.png) files.

Linking a Word or PowerPoint file to OneNote
By linking a Word or PowerPoint file to a OneNote section or page, you can 
open OneNote from inside Word or PowerPoint and refer right away to notes 



Chapter 6: Automating Tasks 
with Macros

In This Chapter
✓ Understanding what a macro is

✓ Displaying and hiding the Developer tab

✓ Examining macro security issues

✓ Recording, running, and editing a macro

✓ Placing a macro button on the Quick Access toolbar

This brief chapter explains how macros can make your work a little 
easier. I describe how to display the Developer tab on the Ribbon, 

record a macro, run a macro, and edit a macro. I also look into macro 
security issues and show you how to place a macro button on the Quick 
Access toolbar.

What Is a Macro?
A macro is a set of command instructions recorded under a name. When you 
activate a macro, the program you’re working in carries out the instructions 
in the macro. Macros help automate repetitive and complex tasks. Instead 
of entering commands yourself, the macro does it for you — and it enters 
the commands faster and more efficiently. Instead of reaching into several 
dialog boxes to get a task done, you can run a macro and let it do the work.

 Not that you necessarily need to know it, but playing a macro involves 
running command sequences in Visual Basic for Applications (VBA), a 
programming language built into all the major Office 2010 applications. 
Behind the scenes, the application you’re working in executes VBA code 
when you run a macro.

Displaying the Developer Tab
Before you can run a macro or do anything in the wonderful world of 
macros, you must display the Developer tab. Figure 6-1 shows the Developer 
tab in PowerPoint. Follow these steps to display or remove this tab:
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Figure 6-1: 

The 

Developer 

tab (in 

PowerPoint).

 

  1. On the File tab, choose Options.

   You see the Options dialog box.

 2. Go to the Customize Ribbon category.

 3. On the right side of the dialog box, select the Developer check box.

 4. Click OK.

Managing the Macro Security Problem
A macro is a little (and sometimes not so little) computer program in its own 
right. As such, macros can contain computer viruses. When you run a macro 
in a PowerPoint presentation, Word document, Excel workbook, or any other 
file, you run the risk of infecting your computer with a virus.

To help protect you against macro viruses, Office gives you the opportunity 
to decide how you want to handle files that contain macros. You can disable 
all macros, disable some macros, or enable all macros. (If you’re working in 
an office on a network, the network administrator may have decided for you 
whether you can run macro files on your computer. Network administrators 
can disable all files that contain macros.)

Follow these steps to tell Office how you want to handle macros:

  1. On the Developer tab, click the Macro Security button.

   You see the Macro Settings category of the Trust Center dialog box, as 
shown in Figure 6-2.

 2. Under Macro Settings, declare how you want to handle Office files 
that contain macros.

  Your choices are as follows:

 • Disable All Macros without Notification: You can’t run macros, and 
moreover, you’re not alerted to the fact that your file contains 
macros or given the opportunity to enable the macros.
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Recording a Macro
Recording a macro in an Office application is a matter of turning on the 
Macro Recorder and giving commands. The Macro Recorder is modeled 
after a tape recorder. You turn on the recorder, choose commands, and 
turn the thing off. Following are ground rules and instructions for recording 
macros.

 Unless you want to construct them on your own using VBA code, you can’t 
record your own macros in PowerPoint, Outlook, or Publisher. (You can 
record macros in Word, Excel, and Access.) To make use of macros in 
PowerPoint, Outlook, or Publisher, you have to obtain them from a devel-
oper or have them already in your files.

Enabling your files for macros
To record macros, you must make sure that the file in which you record 
them is macro enabled. Macro-enabled files have file extensions that end 
in m (the m stands for “macro”). Excel files have the extension .xlsm, 
PowerPoint files the extension .pptm, and Word files the extension .docm.

Follow these steps to macro-enable a file so that you can record and run 
macros in it:

  1. On the File tab, choose Save As.

  2. In the Save As dialog box, open the Save As Type drop-down list and 
choose the macro-enable option.

  For example, to macro-enable a Word document, choose Word Macro-
Enabled Document (*.docm).

 3. Click the Save button.

Ground rules for recording macros
Before you record a macro, observe these ground rules:

 ✦ Plan ahead. If the actions you intend to record in the macro are complex, 
write them down beforehand so that you can execute the commands 
without making any mistakes.

 ✦ Set up the program the way it will be when you play back the macro. 
Before creating a macro that manipulates information in a worksheet, 
for example, open a worksheet that is typical of the kind of worksheet 
on which you’ll run the macro. Unless you prepare yourself this way, 
you may have to pause the Macro Recorder (you can do that in Word) 
as you record, or you may have to edit the macro in the Visual Basic 
Editor later.
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  Avoid using the mouse as you record a macro (although you can use 
it to open menus and select menu commands). The Macro Recorder 
interprets some mouse actions ambiguously. Select data by using key 
presses. (In Excel, you can select cells with the mouse because the 
Macro Recorder is able to recognize cell addresses.)

  When you visit a dialog box as part of recording your macro, take into 
account all the dialog box settings. For example, if you visit the Font 
dialog box and choose 12 points on the Font Size drop-down list, the 
Macro Recorder duly records the 12-point font size, but it also records 
the Times Roman font in the macro if Times Roman happens to be the 
font that is chosen in the Font dialog box. The moral: Take account of all 
the settings in a dialog box when you visit it while recording a macro.

  In dialog boxes with tabs, you can’t click tabs to switch from tab to tab 
and choose commands. Instead, click OK to close the dialog box, reopen 
it, click a different tab, choose a command on the tab, and close the 
dialog box again.

  8. Click the Stop Recording button.

  That’s all she wrote — your macro is recorded. I suggest you test it to 
see how well it runs.

To delete a macro, click the Macros button on the Developer or View tab, 
and in the Macros dialog box, select the macro you want to delete and then 
click the Delete button.

Running a Macro
Before you run a macro, take note of where the cursor is located. The macro 
may require the cursor to be in a certain place to run properly. Follow these 
steps to run a macro:

  1. On the Developer or View tab, click the Macros button (or press 
Alt+F8).

   The Macro dialog box, shown in Figure 6-5, appears.

 2. Select the macro that you want to run.

  Macros have cryptic names, but you can usually tell what they do by 
glancing at their descriptions.

  If you don’t see the macro you want, make a new selection in the Macro 
In drop-down list.

 3. Click the Run button.
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 If your macro is a long one and you need to stop it from running, press 
Ctrl+Break. (On most keyboards, the Break key is located along with the 
Pause key on the right side of the keyboard, to the right of the F12 key.)

 

Figure 6-5: 

The Macro 

dialog box.

 

Editing a Macro
Editing a macro entails opening the Visual Basic Editor and editing 
Visual Basic codes, which is not for the faint of heart. If your macro is an 
uncomplicated one, you’re better off re-recording it. This book isn’t a 
developer’s guide, so it can’t go into the details of using the Visual Basic 
Editor. However, the following pages explain the basics of reading a macro 
in the Visual Basic Editor, deleting parts of a macro, and editing the text in 
a macro.

Follow these steps to view a macro in the Visual Basic Editor:

  1. On the Developer tab, click the Macros button (or press Alt+F8).

   You see the Macro dialog box (refer to Figure 6-5).

 2. Select the name of the macro that needs editing.

 3. Click the Edit button.

  You see the Visual Basic window, as shown in Figure 6-6.

 4. Choose File➪Save (or press Ctrl+S) after you finish editing your macro.

Macro names appear in the Procedure box on the right side of the window. 
Those computer codes in the Code window are scary, aren’t they? You can 
find one line of code for each command in your macro. Edit computer codes 
the same way that you edit text in a Word document. For example, click 
to the left of a line to select it and then press Delete to delete a line. Or type 
in the Code window to add commands or change the text that the macro 
enters in documents.
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 ✦ All dialog box options are recorded: Even if you select only a single 
option in a dialog box, the macro records all the options in the dialog 
box. A visit to the Font dialog box, for example, adds more than 20 lines 
to a macro, one for every option in the dialog box. However, you can 
edit out lines that your macro does not require.

Editing the text that a macro enters
As I mention earlier, text that is typed during a macro procedure is enclosed 
in double quotation marks (”) in the Code window. To edit the text in a 
macro, you can edit the text between double quotation marks in the Code 
window. Edit this text as though you were editing it in Word.

Deleting parts of a macro
Delete part of a macro when you want to remove a command or command 
sequence. For that matter, you may delete parts of a macro if they are 
unnecessary. Deleting unnecessary lines makes a macro easier to read and 
run faster. As I mention in the preceding section of this chapter, a visit to a 
dialog box, such as the Font dialog box, adds many lines to a macro, most of 
which are unnecessary. Your macro requires only the lines that pertain to 
changing settings.

To delete part of a macro, delete the lines as though they were text in a 
Word document: Click or click and drag in the left margin and then press the 
Delete key.

Running a Macro from a Button 
on the Quick Access Toolbar

Any macro that you run often is a candidate for the Quick Access toolbar. As 
Chapter 1 of this mini-book explains, you can place your own buttons on the 
Quick Access toolbar and move the toolbar below the Ribbon as well. Follow 
these steps to assign a macro to a button and place the button on the Quick 
Access toolbar:

 1. Right-click any button or tab and choose Customize Quick Access 
Toolbar on the shortcut menu.

  You see the Quick Access Toolbar category of the Options dialog box.

 2. In the Choose Commands From drop-down list, choose Macros (you 
can find it near the top of the list).

  The cryptic names of macros in your file appear in the dialog box.



Chapter 7: Linking and Embedding 
in Compound Files

In This Chapter
✓ Understanding what object linking and embedding (OLE) is

✓ Linking to foreign data in another file

✓ Embedding foreign data in a file

Acompound file is a computer file that brings together data created 
in different programs. A year-end report is a classic example of a 

compound file. Typically, a year-end report includes word-processed text, 
worksheet tables, and graphics. Thanks to object linking and embedding 
(OLE), you can create compound files. They can include data from differ-
ent sources — Excel worksheets, Word text, or Paint graphic files. What’s 
better, you can copy and continuously update material from other programs 
without leaving the Office 2010 program you’re working in.

All this magic is accomplished with something called object linking and 
embedding (OLE). This chapter explains OLE, tells you how to embed data 
from another file, and explains how to link data from another file so that 
your files are updated automatically.

By the way, OLE is pronounced the same as olé (“oh-lay”), which is the word 
that the bullfighting audience shouts when the bull passes under the matador’s 
cape. ¿Loco, verdad?

What Is OLE, Anyway?
Object linking and embedding (OLE) is a means of putting more than one 
program to work on the same file. You can think of OLE as a high-powered 
version of the standby Copy and Paste commands. As you probably know, 
the Copy and Paste commands are for copying material from one place or 
program to another. For example, with the Copy and Paste commands, you 
can copy text from an Excel worksheet into a Word document. You can 
copy columns and rows from a Word table and paste them straight into a 
PowerPoint table.
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Uses for embedding
Embedding enables you to work inside an Office program on data that the 
program isn’t equipped to handle or display. Embed an Excel worksheet in 
a Word document if you want to have a table with complex mathematical 
formulas. Embed a Word document in an Excel worksheet if you want to 
write paragraphs of explanatory text and be able to call upon Word formatting 
commands. Consider embedding an object if you want to attempt something 
that you can’t normally do in the program you’re working in.

Pitfalls of linking and embedding
Linking and embedding aren’t for everybody. Here are some OLE pitfalls:

 ✦ File size: Including embedded objects in a file makes the file grow in 
size — and I mean really grow. A large file can be unwieldy and hard to 
store. It takes longer to load on-screen. By linking, you solve the file-size 
problem because the item has to be stored only once — in its original 
location.

 ✦ Carrying charges: Links are broken if you move your file or you or 
someone else moves a file to which your file is linked. A file with links 
can’t be sent over the Internet or copied to a laptop without the links 
being broken. Linking is out of the question in the case of files that 
travel to other computers. If you link to files over a network, establish a 
scheme for storing files with your co-workers so that files aren’t moved 
inadvertently.

 ✦ Formatting embedded and linked objects: Unfortunately, linked and 
embedded objects are often hard to format. Selecting the same fonts and 
colors as the fonts and colors in your file can be difficult because you 
have to rely on the commands in the source file to do the formatting. 
The end result is that linked and embedded objects sometimes look out 
of place.

 Before you undertake any activity regarding object linking and embedding, 
save the file you’re working on. The program with which you’re working 
needs to know precisely where OLE objects go in order to execute OLE 
commands. Therefore, your file must be completely up-to-date for OLE 
commands to work.

Linking to Data in a Source File
Link a slide, document, or worksheet to another file so that changes made to 
the other file are made automatically to your slide, document, or worksheet. 
Earlier in this chapter, “Uses for linking” explains the benefits of linking to 
another file. These pages explain how to establish the link between your files, 
how to update the link, how to break a link, and how to mend broken links.
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Figure 7-3: 

Converting a 

linked to an 

embedded 

object.

 

Embedding Data from Other Programs
By embedding data, you can enter and edit foreign data without leaving 
the program you’re working in. An Excel worksheet, for example, can be 
embedded on a PowerPoint slide (refer to Figure 7-1) When you double-click 
the embedded object, the computer program with which it was created 
opens so that you can start editing.

Embedding foreign data
How you embed data that is foreign to the program you’re working in 
depends on whether the data has already been created. You can get a 
head start embedding data if you or someone else has already created it. 
Following are instructions for embedding an object so that you can enter the 
data on your own and embedding data that has already been created.

Creating an embedded object from scratch
Create an embedded object from scratch if the data you need hasn’t been 
created yet. Follow these steps:

 1. Go to the Insert tab.

 

 If your aim is to create an Excel table, click the Table button, choose 
Excel Spreadsheet, and be done with it.

  2. Click the Object button.

   You see the Object (or Insert Object) dialog box, as shown on the left 
side of Figure 7-4.

 3. Click the Create New option tab (or option button).

 4. In the Object Type list, choose the name of the program that handles 
the kind of data you want to embed.

  For example, to insert a space for Word text, choose Microsoft Word 
Document.



Chapter 8: Office Web Apps

In This Chapter
✓ Understanding how online applications work

✓ Understanding how the Office Web Apps work

✓ Signing up with Windows Live

✓ Going to the SkyDrive window

✓ Handling SkyDrive folders and files

✓ Working on Office Web App files

✓ Collaborating on and sharing files with others

This chapter looks into Office Web Apps, the online versions of Word, 
Excel, PowerPoint, and OneNote. Respectively, these applications are 

called Word Web App, Excel Web App, PowerPoint Web App, and OneNote 
Web App. Anyone can use these applications. You don’t have to install 
Office 2010 or pay a fee of any kind. All you need is an Internet connec-
tion and an account with Windows Live. Moreover, users of the Office Web 
Apps can collaborate online with one another to create Word documents, 
Excel worksheets, PowerPoint presentations, and OneNote notebooks. As 
long as both of you are connected to the Internet, you and a colleague can 
work together on the same file simultaneously, even if one of you is in the 
Bugunda Kingdom and the other is in Uzbekistan.

Introducing Online Applications
The notion of using online applications takes some getting used to, but like it 
or not, you’ll have to get used to it because soon the majority of applications 
will be online applications. These pages explain how online applications work 
and the advantages and disadvantages of using Office Web Apps and other 
online applications.

A new concept
Here’s a computing concept that’s in your future: In the years ahead, the 
personal computer as we know it will become obsolete and most computing 
activity will take place over the Internet. Rather than store files on the hard 
drive of your computer, you will store files on a Web server on the Internet. 
Rather than install and run programs on your computer, you will run pro-
grams that someone else installed for you on a Web server. To work on a file, 
you’ll take these steps:



734

Office Web Apps: The Big Picture
To use Office Web Apps, start by setting up an account with Windows Live, 
a Microsoft Web site that offers Web-based applications and services. One of 
the services is called SkyDrive. Use it to create, store, and share Office Web 
App files. Windows Live (and SkyDrive) cost nothing to use. (See “Getting 
Ready to Use the Office Web Apps,” later in this chapter.)

In SkyDrive, you can create folders for storing files online. You can also 
upload files from your computer to SkyDrive and download files from 
SkyDrive to your computer. (See “Managing SkyDrive Folders” and 
“Managing Your Files on SkyDrive.”)

To create a document, worksheet, presentation, or notebook with an Office 
Web App, either start in a SkyDrive folder and choose the New command, 
or start on the File tab in Word, Excel, PowerPoint, or OneNote and choose 
Save & Send➪Save to Web. (See “Creating an Office Web App file.”)

The Office Web Apps — Word Web App, Excel Web App, PowerPoint Web 
App, and OneNote Web App — are abridged versions of their Office 2010 
namesakes. Use the commands on the Ribbon and the tabs to create and 
perfect your document, worksheet, presentation, or notebook. To make use 
of a command in an Office program that isn’t found in an Office Web App, 
click the Open In button (the rightmost button on the Ribbon). (See “Editing 
an Office Web App file, later in this chapter.”)

To see how to use SkyDrive to collaborate online with other people, estab-
lish permissions for sharing folders, and issue invitations to your co-work-
ers so that they can work alongside you in cyberspace, see “Sharing and 
Co-Authoring Files,” later in this chapter.

In this book, I describe how to run the Office 
Web Apps from a server located at Windows 
Live, a Microsoft Web site, but you can also run 
Office Web Apps without keeping your files at 
Windows Live. Using a software product called 
SharePoint 2010, you can run the Office Web 
Apps from a server on a local network. For 
example, you can run the applications from and 
store your files on a server that is owned and 
operated by the company you work for.

Keeping files on a network server close to home 
helps solve the privacy problem. Meddlers and 
spies who want to steal files have a harder time 
getting them from a server on a closed network 
than they do getting them from a Windows Live 
server on the Internet. To install a SharePoint 
2010, however, you need a fair amount of tech-
nical expertise. If SharePoint 2010 interests 
you, see SharePoint 2010 For Dummies, by 
Vanessa L. Williams.

SharePoint 2010: The other way to 
use the Office Web Apps

Office Web Apps: The Big Picture
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Getting Ready to Use the Office Web Apps
To start using the Office Web Apps, complete these tasks:

 1. Make sure you have the right Web browser.

  The Office Web Apps work with Internet Explorer, Firefox, and Safari, but 
not the Chrome or Opera browser. For all occasions, I recommend using 
Firefox, and you can download and install it starting at this address:

www.mozilla.com/firefox

 2. Install Microsoft Silverlight.

  Silverlight is an application that improves the delivery of media over the 
Internet. Installing Silverlight isn’t mandatory, but Microsoft recommends 
it because the Office Web Apps work better and faster when Silverlight is 
installed. To download and install Silverlight, go to this address:

www.silverlight.net

 3. Sign up with Windows Live.

  Go to the address listed here to sign up. You are asked to provide your 
e-mail address and a password. If you have an account with Hotmail, the 
online e-mailing service, you can use your Hotmail address and pass-
word to sign into Windows Live. To sign up, you can create a Windows 
Live ID or use your e-mail address.

http://home.live.com

Signing In and Going to the SkyDrive Window
Sign in to Windows Live by going to the address shown here, entering your 
ID and password, and clicking the Sign In button:

http://home.live.com

The Home window at Windows Live opens, which is fine and dandy, but to 
use the Office Web Apps, you need to be on the SkyDrive window. As shown 
in Figure 8-2, you can use these techniques to get to the SkyDrive window:

 ✦ Click the More link on the Windows Live taskbar and choose SkyDrive 
on the drop-down list.

 ✦ Click SkyDrive on the Navigation bar (see Figure 8-2).

The SkyDrive window lists your folders and how much space the files in your 
folders occupy. (You can store up to 25GB of files.) To see all your folders 
rather than the ones you most recently opened, click the All Folders or View 
All link.

Signing In and Going to the SkyDrive Window
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Figure 8-2: 

Going to the 

SkyDrive 

window at 

Windows 

Live.

 

Click SkyDrive on the Navigation bar. . .

or click the More link and choose SkyDrive

Click to sign out

 When the time comes to sign out of Windows Live, click the Sign Out link in 
the upper-right corner of the screen.

Managing SkyDrive Folders
The SkyDrive window at Windows Live lists your top-level folders. Click a 
folder icon in the SkyDrive window to open a folder. Starting in the SkyDrive 
window, you can create folders, rename folders, and delete folders, as the 
following pages explain.

Creating a folder
SkyDrive gives you two folders for storing files. These folders are called My 
Documents and Public. (The Favorites folders are for storing shortcuts to 
Web sites.) Follow these steps to create a folder of your own:

 1. In the SkyDrive window, click the Create Folder link.

  The Create a Folder window opens. If you want to create a subfolder (a 
folder inside another folder), open the parent folder before completing 
Step 1.

 2, In the Name box, enter a descriptive name for the folder.

Managing SkyDrive Folders
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You can’t rename or delete a folder if you don’t have permission to do so. 
For more information, see “Choosing Share With permissions,” later in this 
chapter.

 

Figure 8-3: 

A folder 

window.

 

Creating and Editing Office Web App Files
To create a file with Word Web App, Excel Web App, PowerPoint Web App, 
or OneNote Web App, start by opening the folder where you want to keep 
the file. These pages explain how to create Office Web App files as well as 
how to open them, edit them, and find your way around the File window.

Creating an Office Web App file
I’m happy to report that creating an Office Web App file is quite easy. After 
signing in to Windows Live and going to the SkyDrive window, follow these 
steps to create an Office Web App file:

 1. Open the folder where you will keep the file.

  See “Creating a folder,” earlier in this chapter, if you need to create the 
folder or subfolder first.

 2. Click the New link and choose an option on the drop-down list, as 
shown in Figure 8-4.

  The Word Web App, Excel Web App, PowerPoint Web App, or OneNote 
Web App opens so that you can create your worksheet, presentation, 
document, or notebook.

Creating and Editing Office Web App Files
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Managing Your Files on SkyDrive
SkyDrive is first and foremost a means of organizing and managing files. You 
can take advantage of commands in a SkyDrive folder window to upload files 
to SkyDrive, download files from SkyDrive, and delete, rename, move, and 
copy files.

Uploading files to SkyDrive
To upload files from your computer to a folder you keep on SkyDrive, you 
can start in SkyDrive or in Word, Excel, PowerPoint, or OneNote:

 ✦ Starting in SkyDrive: Open the folder where you want to store the files 
and click the Add Files link. The Add Files window appears. Click a Browse 
button for each file you want to upload, choose a file in the File Upload 
dialog box, and click the Open button. Then Click the Upload button.

 ✦ Starting in Word, Excel, PowerPoint, or OneNote: With the file you want to 
upload to SkyDrive open, follow these steps to upload the file to SkyDrive:

 1. On the File tab, choose Save & Send, and choose Save to Web. Save 
to Windows Live options appear.

 2. Click the Sign In button, enter your Windows Live ID and password, 
and click OK. A list of folders you keep on Windows Live appears.

 3. Select a folder and click the Save As button.

Later in this chapter, “Downloading files from SkyDrive to your computer” 
explains how to do move files in the other direction — from SkyDrive to your 
computer.

Moving, copying, renaming, and deleting files
Starting in a File window (refer to Figure 8-5), use these techniques to move, 
copy, rename, or delete a file:

 ✦ Moving and copying: Click the Move link or click the More link and choose 
Copy on the drop-down list. You see a window that lists your SkyDrive fold-
ers. Select a folder name and choose the Move or Copy command.

 ✦ Renaming: Click the More link and choose Rename on the drop-down list. 
Then enter a name in the New Name text box and click the Save button.

 ✦ Deleting: Click the Delete link and then click OK in the confirmation 
dialog box.

Managing Your Files on SkyDrive
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Downloading files from SkyDrive to your computer
SkyDrive gives you the choice of downloading files one at a time or down-
loading all the files in a folder in a zip file:

 ✦ Downloading a file: In the File window (refer to Figure 8-5), click the 
Download link. You see the standard dialog box for downloading files from 
the Internet. Choose to open or save the file after you download it and 
click OK.

 ✦ Downloading all the files in a folder: In a Folder window (refer to Figure 
8-3), click the More link and choose Download as .Zip File on the drop-
down list. In the standard dialog box for downloading files, choose to 
open or save the file after you download it and click OK.

Sharing and Co-Authoring Files
As I mention at the start of this chapter, one of the great advantages of Office 
Web Apps is being able to share files with others. Microsoft uses the term 
co-authoring to describe what happens when more than one person works 
on a file in an Office Web App. As long as all parties have Windows Live 
accounts and all have permission to edit a file, they can edit it. These pages 
explain how to handle editing permissions, how to invite others to co-author 
a file, and what being invited to co-author a file entails.

Choosing Share With permissions
Whether others can open a folder on your SkyDrive page and view its files 
depends on which permissions the folder has been granted. Likewise, per-
missions determine whether others can add files to a folder, edit files, and 
delete files.

Types of permissions
If you intend to share files with others on Windows Live, you need to know how 
folder permissions work. Folder permissions fall into two broad categories:

  ✦ Private folders: Only the owner can open a private folder, view its files, 
add files, edit files, and delete files. The default My Documents folder is 
a private folder.

 ✦ Public folders: Everyone whom the owner invites to visit a public folder 
can visit it. The default Public folder that SkyDrive creates for you is an 
example of this type of folder. When others come to a public folder, they 
can do these tasks, depending (again) on which permissions the owner 
has given them:

  • Public folder for viewing files only: Visitors can open and view the files 
in the folder (but not edit or delete the files).

Sharing and Co-Authoring Files


